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Keyman Developer Tutorial

Adding a Touch Keyboard

Session 6
This session we will modify a desktop keyboard for the Dagbani language of Ghana to add a touch
keyboard for Dagbani.

1. Start Keyman Developer.

2. In the Project menu, point to Recent Projects, click DagbaniTutorial.kpj.

3. In the Project - Keyboard dialog box, click Keyboards. Then click dagbanitutorial.kmn.   The
Details pagee appears.

4. Click Touch Layout. The Touch Layout page appears.  There is a Design tab and a Code tab. 
The Code tab shows us the code that Keyman compiles to build the keyboard.  The Design tab
shows a pictorial picture of the keyboard.  We will be using the Design tab. Click Design tab.

At the top of the Touch Layout pane, in the Platform dropdown, we can select phone or tablet.
These are represented by iPhone and iPad graphical representations, but they will work on
Android as well. We have the flexibility to have a different number of rows or columns of keys on
the tablet and phone layouts, and so Keyman keeps them separate. If we want the exact same key
structure on both, then select one of the two from the Platform dropdown. It is a lot of extra work
to maintain two identical layouts. Keyman will automatically use the tablet if phone is not present
or the phone if tablet is not present. Only if we want to make the tablet and phone layouts
different, would we want to have both.  In our case, we want select phone only.  So, click on the
adjacent Add and select phone in the Platform dropdown.  Then click OK. Now select tablet in
the Platform dropdown and select the adjacent Del buttons to remove tablet from the dropdown
list. We should only have phone on the dropdown list.

Note that another option for generating a tablet keyboard is to import the desktop keyboard by
clicking Import from On Screen since the tablet platform has as many keys as we have on the
desktop platform.  Doing this would mean that the tablet keyboard would have the same
keystrokes as the desktop keyboard to generate the special characters.

Our touch keyboard will have three layers: default, shift and numeric.  We will initially work with
the default layout. So, to indicate what layer we are on, set the Layer dropdown to default.



 

The Touch layout tab has a Character Map pane that we will be using to enter special keys
onto the touch keyboard.  On the bottom of the pane, there is a Search box for a short
description of the Unicode character that we are looking for (e.g. open e). The search box acts
a filter of all the Unicode characters. So, by entering open e in the search box will display
only those characters that have open e in their description.  When we find the desired
character in the list, we click on it to select it.  It will be highlighted.  Note that above the
Search box will be a full Unicode description of the selected key. To copy the special
character to a key, select the key and then double-click it.



 

On the Touch layout page, we can start handling the additional characters. Remembering that
all special characters on a touch keyboard must be visible somewhere, there are at least four
options to add them to an existing keyboard. In the case of adding an open o to a Latin
keyboard we could:

Placed the open o on an unused key, like x.
Placed the open o on a long-press popup so that long-pressing o gives the option to
select it,
Place the open o on a different layer that appears when the activating key is pressed.
Keyman has some different layer names (based on keyboard modifiers) that are
predefined, plus a numeric layer, but custom layer names can be added.
Add a dedicate open o key to our keyboard.

​​​​​​​5. So, let's look at the first case.  We will replace the x key with open o.  Click on the x key and
delete the x. In the character map, search for open o. Click on the open o (U+0254). Then
double-click it.  Then in the Code box, enter U_0254.

We will replace the q key with open e.  Click on the q key and delete the q. In the character map,
search for open e. Click on the open e (U+025B). Then double-click it.  Then in the Code box,
enter U_025B.



Now save our work by clicking on the Save icon.

​​​​​​​6. So,let’s look at the second case.  We will add a long-press on o key for the open o. Click on the
o key. Then click Add longpress popup.  In the Character Map, search for open o. Click on the
open o (U+0254). Then double-click it. Then in the Code box, enter U_0254.

 

We will add a long-press on the e key for the open e. Click on the e key. Then click[1] Add
longpress popup.  In the Character Map, search for open e. Click on the open o (U+025B).
Then double-click it. Then in the Code box, enter U_025B.

If we need to add another character to the long-press popup.  Depending on where we want it
to be on the popup list, click one of the two plus in a green triangle icon and enter the current
long-press character. To delete a character from the long-press popup, select the appropriate
popup key and click the x in a red circle icon.

 



Now save our work, by clicking on the Save icon.

 

​​​​​​​7. So, let’s look at the third case.  We could add the open o to the numeric layer so that tapping
numeric keythen vertical bar key will produce the open o. First, we will change the Layer box
to display numeric, by clicking the down arrow of the Layer box and selecting numeric.  Click
on the vertical bar key.  In the Character Map, search for open o. Click on the open o (U+0254).
Then double-click it. Then in the Code box, enter U_0254.

Now save our work, by clicking on the Save icon.

 

​​​​​​​8. Now let's look at the fourth case.  A touch keyboard has the advantage over physical keyboards
in that we can add and delete keys from the keyboard. We will add a new key for open o between
the space bar and Enter key.  First, change the Layer box to default. Select the space bar. Click
on the right plus in the green triangle icon. A new key has been created between the space bar
and Enter key.  Now we are ready to define it.  Click on the new key.  In the Character Map,
search for open o. Click on the open o (U+0254). Then double-click it. Then in the Code box,
enter U_0254.

We can shorten the space bar so that row of the new key could go back to its original length by
shortening the length of the space bar.  Click on the space bar and in the Width, box change 610



to 550.

Now save our work, by clicking on the Save icon.

 

​​​​​​​9. Now that we have looked at the four options for adding special characters to the keyboard, we
use the long-press for building our Dagbani keyboard. We have already added the open e as a
long-press of the e key.  We can tell a key has long-press key(s) by noting the diagonal line in the
upper right corner of the key. We already added the open o as a long-press of the o key.  So now
we need to the other three keys (eng, gamma & ezh) to the default layer of the keyboard.  First,
verify the Layer box is set to default.

To add the eng character as a long-press on the n key, click on the n key. Then click Add
longpress popup.  In the Character Map, search for eng. Click on the eng (U+014B) character to
select it. Then double-click it. Then in the Code box, enter U_014B.

To add the gamma character as a long-press on the g key, click on the g key. Then click Add
longpress popup.  In the Character Map, search for gamma. Click on the gamma (U+0263)
character to select it. Then double-click it. Then in the Code box, enter U_0263.

To add the ezh character as a long-press on the z key, click on the z key. Then click Add
longpress popup.  In the Character Map, search for ezh. Click on the ezh (U+0292) character to
select it. Then double-click it. Then in the Code box, enter U_0292.

Now save our work, by clicking on the Save icon.

​​​​​​​10. Next, we want to add the capital letters for the five keys to our touch keyboard. First, we
need to set the Layer box to shift.

To add the capitol open e character as a long-press on the E key, click on the E key. Then click
Add longpress popup.  In the Character Map, search for open e. Click on the capitol open e
(U+0190) character to select it. Then double-click it. Then in the Code box, enter U_0190.

To add the capitol open o character as a long-press on the O key, click on the O key. Then click
Add longpress popup.  In the Character Map, search for open o. Click on the capitol open o
(U+0186) character to select it. Then double-click it. Then in the Code box, enter U_0186.

To add the capitol eng character as a long-press on the N key, click on the N key. Then click Add
longpress popup.  In the Character Map, search for eng. Click on the capitol eng (U+014A)
character to select it. Then double-click it. Then in the Code box, enter U_014A.



To add the gamma character as a long-press on the G key, click on the G key. Then click Add
longpress popup.  In the Character Map, search for gamma. Click on the capitol gamma
(U+0194) character to select it. Then double-click it. Then in the Code box, enter U_0194.

To add the capitol ezh character as a long-press on the Z key, click on the Z key. Then click Add
longpress popup.  In the Character Map, search for ezh. Click on the capitol ezh (U+01B7)
character to select it. Then double-click it. Then in the Code box, enter U_01B7.
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WpctO82EnQgY0rp168jIyB07dhw5cuTMmTNibQvQGOfatrC77uXnM3UeHtn7jSJ+osjDwyN13c
s6D/5FQQWK2mEs3DSqDFevXr0VJ66owPCtbtWqVd9++20VvKhiGUsiyJzi2dCmmUX7VH6hLB
fLtjlnchGnp3vYz5v8bfdySMEJ6aXJ6K3LRNyEuIYiQ7qc4hoRx3e3rt17e/fs271Xv6Gj/Dr36FOzVh
0hjdWHNu07jfSfIJl6oSwX9ME/3c0eyiC7FsGunPTp0yczM/PNN98sLi7GCmJVG6AxFWnbifd2tjEK


7xWI
px5Dvb4jSUda58EqISNmA9pF7PhN7SgkrzT6cw9t8QbfC1PYQWl1XdX/ulu2dbtOHpp0iO5zHg
plbEZb62o1Yy3iGuzDlx92UKSp2A9g4zjtWy4d5tC++eUekNvN9ofA7gnzKlExswg3w7R/RcVkg
h1iarD1W2lauiZqgBSscijSb0mEJVYRoEZp36RLFzH4x5yS6oAKRutNIzoRBxHUiaj/MY9LGpzgw
ZsfPGGSZOLS0Ag81NuV6J6bcJGmTFAryREeLTWV6l6PLgSRd4MKEqctFnIbIwP5hnymHJAC7
hjPkjZkwto88Clks0k6ZRHxmEZ1F0s4qYlraU9JBKSLpc4tND+ewl1qJXb6Qc1hMxQphu6yKOG3
H6A1TKeTw5YaQsF2UALb2kXZBajDtAplo9uEclOIlzECuSFVJaO9IfyW19TUeMpnwGUW8KBP
hivzDsnwqJYk4bQdTFt6yzZKJit0AbZ8F3syiTX6+9AlEbTbfFxLKIp6unFaxGjNFwIs2YIpZflLYFvNZ+MNlmsFr1LHt0AqskadZgjdDbJaLOPtjLAVoB8lEpLrW4LuqiaKdFTex3aqEooWWhnVEpFd
D1Oyga01U7AYUFTlkYhNuQFGRO4zHqXuRKhKad9chORPmFhHXTDPNNNOsckwTcc0000yz
amy6nj17GqID7oi1b9/e29ubDfKsoaGhoeEUum+/vUiS2qpV2/79h4SGxkRGJkkWEeGMScWjoph
FRzOLiUmKjWUWGRlDNSYkJP7nPx/93//9+NNPP8M0NDQ0NBxFd/78TySpvXsPzMnZ+uGH3
5w48dOJE5eOH7907NilTz9ldvSoKqOVYSiI4thIScnPn3328xdf/Hzq1M+nT/909uxP589f/Pzz81R
jfHzSv//9IUT84kUm4pqOa2hoaDiK7quvhIgPHTr0hRdeuHz5sviV2tVcu2Y4ffrK+fOXP/+8VBLx9dLjx
0tPnCgtKSn9/PPSpHdTT53679Gjn1ONCQmJNACWpuAaGhoazqEbMd+TJLXyLS1t0kcfHf7hB0
3ENTQ0NJxEN3KB5/C/+43YNWLdXzf8618fvfeesIMHK2q0Hdrm4G2DYf1S6vXjibVvr4d8f/75F
99/f0FTcA0NDQ2n0QXsC5BsycdLf/zxZ9gPP8jtkiNmVpa2Jq9CsqUfL9XkW0NDQ6OC6EhJLY1u
+6uIKTaoMA0NDQ2NiqMTf40opNYlpuFuFD823Dt29OjRb775hj1ooKFxr6IUcY1qx48//kiK1r59
+86dO/v4+Ay82xkwYADtMtI7duz49ttvhS80NO49dIq332tW7ez06TOkaL17916+fMW///2f48dP
nDhRfBfbp58eo13u06fv+vUbkKPwiWaa3TumiXi1N0nE+/a9VxTtHtxlzTSzZa4X8Xnz5omn7Kse
aJuitRWxKrKnf/zxBykaDZwwY8YMRTsVVpUPULnQEXSriFeCf1wbh5rd46bz1fnizxszdYctlpFl6iopuKVxojDccdWxfOva0ZRxmdoZx2LlH5+qBLEzpVOTnYfkKDnSL9osixgQhVUT1StCmyFcwGiYJpjz
qgLeMw81MMCJnGWXu6MBA9N8gxZpmsH8gqV8Fx3qIICXfBogJLBbf1Swv5CscJ/mHTPOEiF
hN07pHUmnzCP5+NnuGRxHJMkcRXwyw2SF25TMQodyxtk+oSmyWH++XRAaL1YfYVnPW1e
Sk2pSJ0VhQZdcS4lEw6u9j5zPXaioLTVDVwrEhx6LjIFVyXuh0KTodSOog4uChYvoKLqyisD46py
j64KWz4+vRpQUilrJvogzMj8ZUOHE4Q+ZHCkZUfMiQUcUL+Z84XJ5dJweUdI+mIkIJTWi648j
44lvD+Mp1fF5jKAj6CMS0lcN4BHFDSXBJ9aYPUi8dxz+Ebwcp8m4Cdv6LTbTy7afbCK1SFmYI
D+FOkOLRHts4v5kDuAdkJYuqDY0rqJKmNFNt8BZsKLtw+s8iobNb74Ox0lik4iaHUBjruVCMva
FoqKbh0TI1bcJex/XGfiWNCx9hF0JalU1cllidwudD6jhqFiDVjfV6LTAcskweZVaNggqn/JZMUx75/
QKSEpK6dfP2qOcB7W7RokUFFfzBBx/s1KlTTk7On//8Z2g3IZY5dB0cXeNFixbJFXzy5Mnog0sK
HhERAQUPDg4eN24cFFz+QKajoEl9+vQp9+nNe0TB2TkQJU4A2LWogK1bt3777bd//PGHWE
NDo6pyM2ehFLqwSZ3aQR/efvvty5cvizWqABX+JRMK3rhp02Z169YLDw3r3atP506dmjZpUqP



Gk02bNm3UqJETCn7//fdD/aG3f/rTn142IvTbCQXHOnPnzpUr+NSpU+0r+COPPCIKO0WNGjW
6d+8uZmxwjyi4Xq+XnwOwlyJD9u3b98svv4g1NDSqJL///vvthCApbn+N8OvatevatWvPnz9fpfofuZ
TikaH/+Mc/rl69Cv4O6cY5A47gCUH7/SVok/eShr1YVCg30Zuxod26ddu0aRPYutP+z+bw4cPU
U6wCjKhu3Xpg1p6enmmpY9LT0nsG9mzmjn5VDzG8WbPm27dvJ/YNUPPGEAcH4x4wYEDdev
Xq1Klbu3YdmH/JkiXUuSWof1vh4BEREStWrCjXwRMTE+3k4PD9C7YCfaNP5cqV6R54YoAU8/
HHHz+Susfd+LCFCxeCrZeljri5KOvSpUvitLigorha8gNplvel9glq26xZRkbGkSNHnLllHjx4kHq
KVYCD165du27duh06dIiLjstIH+vvH9C4cZMGDRrWqlWrSZOmZhwc7NvX169+gwYQ4uvVB8
evDz4Ojjd//nxq3hjq30Yc3LscB580aZJRB4fv745x8BYY+kafJ9DBIcX873//O7dQdy7lk6jwXzJTYer2nTpkEGd9r/Fwkeb27evPkgRXcXFNCduLCx3u27d+8+Y8aMDz/8EFm8U6LQwStVqtS1a1cwVnBkgs7BW7SoVbtOe0/P5MSU9DH
pPQJ6NG3qDukbPmXGwV944YWY2DhPr47uHu2qNvTu5JXeyCO4ZsMWDRq5ubu7b926lfo3xoiDK7mz1fjx42UHX7hw4bx582QHnz
RpEu/gBw5FRkaq6+AeHh7Nmzenb/R5Ah38zp071+ZNYTuJrPW9usHx9eLFi8LBBRXC7du376dFyg3yRHjfVq1agRusWbPms88++/
333522ZZbr4OQHpWCp2zDEvgHZwVu0aFm7Tl3ImmNGo2tRAnuga1GUOPjKlSs7de7SsVOX5q3ag3fXb+LRxB0962fQoEHUuSWM
OLiSDB4SEgIODocdUw6enp5uVwfv1KkT2RCGPIEOTk6CP7887w7j3USzA3xzcnL+85//iP9kCioE9HP5JPQF8VZcaKtm7n379p09e/a
bb7556dIliOfO3CxNOTiYL/jb5s2bwbsJJh28pUftuuhywPS0MT0De/r5+nq0bFnuWRQATBy8tHMXn47endp7enm0auPu3rxz5y5FRUX
UuSWsdPB27doZOjh8JzLv4OHh4WYXq9TBYSEBAQFVq1al7/WBLzWr8jc9acpdkT995rzI6LjsAX20caGygw9v3yY0fNiCxctWrt3IfURI
yAFasWZDwbTpc0KD27bz9A/oGRWbMC1r7pJlq2E8N6ezafykadRTMGA4w4cPX7t27ZYtW57HUP826+B16tZv06Yt/k/mMPKfTPKM
BHiFj1D/xlDzxoCDA7CE8PChHTt6+/j6QT4286MePQfvpOBZ9VCZch08NTWVOPjB4sNKHBwmbdq83c+vK31vGpjTzG8yK1WuvG7
LridQqzfsWLJ8/aRpc8KHR+0PH/gAnxMPaN1qZHTi0pUF+ZuLuPmFhBwgaHi5qzaOnzIzKQ1eFuSsLFizcQc3j3Mqc/pc8BOIzL169c
rNzYXQDd5NUOzgrRo3dW/UqFFCXEJgj55dOndu3rw5eUaCEgfHv8rUgX5Wb/Znmdj/lDk4TF2+fHm5Dp6UlJSaOvqjjz9dtmw5HL7
Awck3CENggf36B23esr1Ro/IfwwabwN/fn74xABwcGs2TqbWbClese35Bzqox46cOCh76/MC+nX26Jo0et2zNJm5OISGHac3GnXlrNy
9bvWnV+m3QRLmpTqtFuavB3DZu3Lhp0yawb8sdfEPb9p7tPL38fP2iIqPS0zK6devu1qhx3bp1wabs6eBdA5Q8qx5iNTj4kiVLzDt4fH
z8xk1bDh/+5P0DH7z97sGt2/66vmD72nVbV67enLdiQ25ewbLlBcvhsLx284aN28eMGUeXbpa2bdvCYY2+MaBSpcrQSlht373nS/sAS
+bKAn30yad0sqooL+vYsWOffPLJ3r17169fD1+VXnvttSNHjtBpyiBlcQ3aTvWCxXIFgR7LskztL9uBxcpNQpYjy7JTF6vYstZv3gneTbD



IwQFw8A0bNnTx8fXx9fP18RmbMTZt9JjevXo3b96C/APPrhm8/PPgQM2aNQ0dfOrUqYYOHo2JiooaMWJks2bNIEEDT4OeZvTMM1
WqVKGLNgusWO/evZ966in63gBwcDjms/rll1/o/ybUBpbMlfXhx/+k09TG0rLu379//fr133//vdyfve3bt48OSZCy2NYM7ZtOswNc53lsy7
Jb2wBg4Wthl0lyZFkgVboYLMTwUd3QyNk2D1KlLKNwZa3bvIP696ZNw4cPDw0NDdMnXJ+h+oSEhDR1R9SuU6ern5+Hh0fTJk3q
1K5TGT/bADwQPgKLJeTk5FDzxjjCwQFwbYUODoEd1hLWuGXLlvTD1gJHsE6dOtE3xgAHX71hByu6f+wDVxYczOkEO2C/sgxNHJbP
tma71gsWLsqykQosC0Qn2IyhiUNZbJsH0Ql2gCsrf9N26t+bNhWe0Z7WloBra88UhRWXFGEHP12InVuCOrcEOHhzfPMPNze3pk2a
erb3rFu37jPPVAXvBpviHByg5o2xycGVXItCaNKkCevgWVlZxMHHjx9vysFN/ZBSIbBWAQEB5tO6cHDr4EzcrmVxcD1HlGUFFVgWi
E5QA87E7VoWB1cW6+AQwLGDF53eCdZ98CBx8EOni8LDwdPDww8WhR8sHjq0rLRYe2aX7OAeHq08WrWqVbNWBy+vxo2bNGz
QoGbNmuT8gR0dvFNXpQ4OTJ48uVwHj4mJkR3cz8+PftIq6tevb+p2KDLg4KsKtrOi+8c+cGXZtefYuyzWxO1dFgss3JFlrS7YLutxKsu
R25AtC0QnqARr4vYui4UrK3/jdvJvTMbBaQbHBg4ZvKjkEHFwhLa0BEwcKNGeIQ7eug3C3b0ZBHBfH9/GjRtXq1aN3BZbiYMD1Lwx
ih1cwbUoMlWrVlXu4FCrnj170k9aDqxSYGBguSsGDr5y/TZWdP/YB64su/YcB5Qlm7gDypKBhTuyLLaXPk5lOXIbsmWB6AT1kE3cAW
XJcGWt3bCNdXCAGLcMMW6ZM1otNnAKOHjbtu3atm3bpEmT7t27d+ncpXnz5rVr11Z+FgWg5o0x6uAA7+Cdu/oruRZFBlZu/vz5s2
fPVuLgAwYMoB+znI4dO8J3EPrGNODgK9ZtZUX3jwLyJ0bCErwGRJ77lY4pF64s8z3n8s4gTbIu50JZe0rpcNntwxpNEB02gUVlyeyJxt
tFRx6dYAJi4rD8lYwUlkVLwNvw8lU6slxQz7GwrCO5tCCWvKN0qhlQWUwvVVLW7aN5Gk0YfYMJhB33PR02gxVlAVAROoSBt0fooDl
g4Va0DeDKK6jNYyLpqPLgygLRCeVx9cL+oB4eUFJ67h46yjTExK0ui1QJiJy4hY4qD66stQVbLXJwgHg3ARy8ffv27dq3r1u3boB/AHq6
b9OmMFypUiVYK6sdHKDOLcE7uPL/ZMqATRs6+OjRow0dPDg4mH7GQuALiKkbgnOAgy/Pf54V3T/lcBI+O3M36iy3vz/iptEkvHKZT
DAPV1Y5PQfZtC8dLrsMJbqtOEnfvBSpmX2YDJvCsrIkwMEjX7lC3ygDTHxF/vNsa1ZYFtSI2M3lo0UwTOtWHlzPUVgWwdLaWVcWm
NzM4ttk+OrbmRqfhWTYPNaVBduNDmHkTWoeVBbsMkkKy6KgQ1Q5x3UWriwQnWCW/VPAuz3O/Yo24/416LBBN6hpwMShLK7Z
02nlIW9GUhYZNg9X1pqC52UHN/hPJjoVflpbdlqrBSMmJ1IOlvIZ3NPTy9PTs2nTpu5N3b3QfzLrVZX+kzn346vwiUNgix+UYgPXc3D
AegdX/p9MmaeeeiotLc28g48YMQJqBccx+hlLgK8e7dq1o2/KAzn42i2s6P4xSzocq/WM4AosqtwWBnBlldtzdIv9dGHm23DYyCTv8tw0
RRfIoEksLYtghYMDqAimNSssC2on2w3USGG5XM9RWBbBCge3pqwb6IFbZBAGFJZnXVlyQQR2k5rBynoRLHdwtiwQnWAOlJDYDn
Uk11cTWkTfmAaVpd/s6YTyYDcjWHi5nQvgylqzXufgYFzg4KGhhfQ/mfhUeNEZrVZ7Gry7rPQgcXCt9szQQyVgdCXaMyVlJV5vXPLy8
qpdO/vzVR2uXbvWcNE/a87/pFKl2YdnaP76bZns4LuHD4cP2nhJuE0ODoCJp6SkcA6enJxs6OCWLhnsu02bNvSNAsDB89ZuYUX3j1n
gg9yX/kxo1MfpsBm4ssrtOTOlxgTWAz0TysWjjayAIZaWRbDOwa0rC2oh2w3UdKGyi61h4VaURbDGwZleqrysolBN4IqTh2e7+eYqcV
SEdWXJTYLAblIzwMKt3oZWODhbFohOMA06V+OTT99QkKfTQdNYURaBXbivRrNPQRvhylptxMFDpf9kkgwOwRxl8JJD8IIc/Iy2jDg
4ELLj9KWySx06dGjSpMm1ixfXdV7355/nn5v7cdWqczkHhxf4qO0/6oEqIzpbci0KC3xk2LBhxMEzMjKMOjgcuMiXCIWgSymbNqVvlA
EOvmzNZlZ0/5gDJW46KKHQGriyyu05J9f7ahahLgmtCl6LBpP+eZk5u2ISS8siQEVYFPodLD+PkcKyYPnEbk6+AkdANzxYPqjnWF4
WwQoHZ3upJWVdJRuQvlOAdWVxRcBbhQ5uRdugWO7gbFkgOsE06P8WBkc+JRvTirII0sJvF00J1GgC8XA5cGWtWreFOw8OgIOxIO
dmIN5NCAkt/Hx1R6BOnTpdu3br5N2peTP0n0yjv+gBVHPwTn6W/SeTo127duPGjZMdPCEhARx81KhRsoM3aNCAzmoWCPWwqOe
ee46+V0ylSpVyV29iRfePOYw4uMKTAFxZ5fecq/s1mgRsBzPRu7czUSmfLtRM3E+mm8HisjDWZXBY/jJGCssiuwCTTkcpAPUcy8siW
OHgbC+1qKwji4zYkBmsKwu2HR3CwFuFDm5F26BY7uBsWSA6wTTIwfkWbqTTGWJFWQTUBhFumZvK71kErqxV+ZttcXCYuXPnzl
5eXmBiLVu0bN26NYTxGjVqkNWqVq0azAORl/q3ig5u3VkUFjjIREREmHLwtm3b0vlMA0cqhf+3NAQcfOmqjazo/jELfPCw/mlvGLNf
wdUUXFlKeg4suexCke968n++kxq3vH3JmvxT+J1ZrCgLsM7BYflsa1ZYFlSN2E0YxB5LzjZYURbBCge3uiyjQdIM1pUF25Btd/BWyT
+EUVmwyyRZVC9rHJwpC0QnmOFUPnc9D3QBJd87oSy2zYPohPJAvcxCuLJW5m/i/pMJpqwtJb/mof/JpM4tga0bU4h+2OPv7/+PS2X
kdn7g4888rTv9AG4O9u2kDk6AgwxU2NDBzf+op2bNmu7u7mZue1IuyMFXbmBF949ZTq4P1LhBNKac25nANzgTcGUp6TmZEFDT
dCfmYJ19lf1zzIqyACsdHIpgWrPCsqAuksPdhuG8o0r+Gcz3HIVlEaxwcKvLssLBrSgL/QNGt93QBUt00Cy21MsKB2fLAtEJZnHTaBYW
645NgRpN5tvlRyRUln6zpxPKQ+F2Y+HKWrlW5+BgZdTB0Yxa8qOeojPoJHh44emD4eHkhDhYXMmhoehnmYdKdg0tfn/wkKPXyirP
/BBW5uqHM2d+eFWz+xwMf/NC5QEDBtjLwa24mtAMsJx27dpBxcDBIyIioNr9+vWj0xiqVKlSv359cu9zGwEHz1lRwArvnfIpSkNXqk
ooOnEGcGUp6TnoVDjTvBai4hSdMraiLAA8Th9FfTVn5QZWCsuCpesc7tf98FbJJZmwcCvKIljh4FaXZYWDW1UWvszUOyhogBcMFH2
j9ChoVVllV96eia/R9ggajE7rKYErC0QnlMNV9s7RQYvKuXaWgMrSb/Z0QnlAEXRIMVxZK9aCgfMOjvI3859M4uBF4eElZVpyNSHr4
MURESduUAc/PEMD9g0mDgYVGBhI7Bug/u20Ds4C3yMaNWrE3tzqmWeeqVq1Kjm1rxawgZYsX8+K7h/FwEIUdRoMV5bynmMFD
i1rRQEru5YFC3dkWWwvfZzKcuQ2ZMsC0Ql2AJWl3+zpBDvAlbV8zQZF58EL0QWFBHBwDoit8CkfH5+mmDe/vw5vS7VnqH+X5+A
ANW+MIgfvbNt/MisccPDFy9ezovtHMZlumsBcGhByXrpVVnZrw3u6W+3k5PwJom/KyriyrO45ORvg+9kdXBzmBHqA9/4NqKAXc+j
DvNUqC3PnxROolP0/0fdX3ruGq3aNvIXls63ZprJOXIeQTOpCeBFvQ/n0Ltdz1K3XBlyWvMtULYtvHqSOJ1+yQ1kG23D/BrSnYK+Rt7
Bw9doGgm+QZbdgG5IvO1xZIDzaGsj6Q3sgbzGoILlcFcsCyAaUGznAtQ22IKUOzkBtmwEcnIXaNgP1bxscHOAd3E4Z3DGAgy/KW8e
K7B6LyIxAX2CDNp2EloQcQULunHIL48qyuudAh2GPE9B5wIM2vHcLbE4er1ZZGHA6tHAZ2QsIi/PWsbKprBPXT+ov/EXcheR6oZ6j
VlkG9QLkvQagsphealtZqBmwzQPIeUkrj1GzLINtaMTBVduGCIMGWbYBeTqCKwtExlsBrD+7dwB85ADoToSyuGaPR1sJOLichwikOL
LLuLLyVhfIDq77T6b2dEkx8m780x56IoX8JpOcFqfOPRSfS5EcXFtaTAaobTNQ/7bEwQHq3BJ6Dm7Rna2cEHDw7GX5rNDOsRboolK
TQhg6OFeW1T0HSsnh2tZLWmzf6JWgVlkYcLo7bBflHByWz7Zmm8qC/AgGRN8gwMHZ4rieo269AM7B1SuLbx6Avcoy2IaGDr4Idpk
kG+sFGDZI1sHZskBkvBXA+iPRdwhpe+ocnG3zIDzaSsDB2e8xAJfB2YKWrUIOTkwcvJs4OEAcHH2g9CD7m0zi4GWlxUOH7jpTqHN
w7dldsoMD1LklqH9jBzdq4tS8MdS/y3Fwa3/R4yQgB89dywrvHSvBTs1+l+TPonBlWd1zSMNl7YA0NbbBqVUWBp9t+EkXGKEj4apR
R0BFMK3ZprLwGQCwNrmjkgwuf3fmeo669QI4V1WvLCPNw15lGWxDw7MNqpWFMWiQemdR2LJAeLQ1kCOQvqsa1Eu/2ZPx1kE
K2sD0X7bHcWUtW7XejIMD3G8yDR181xktWLbDHdz1z6IsXLqG1S82P5ZJcjd66hY6EtnxsGSurEMffIhnsZafIPigglgDIqhfFgbVBZfI
WINUVu5aWYcOf0Sn2QA5/Q2i7yVg4aqXxe0yGVg420tdrixHbkMM9tOcP9mvNVxZINu7GPfvChlo5GybB9leFkDK4r5kcGXlrlzHOrg
M9W8Mcm598BkUHdS2GahzSxD7jo6OVs3BH4Pz4AuWrmG1ZsO248fh+KoysExYMlcWCNoBnUM9KqQstjWD7FEWYNhFQY9lWX
baXwAsVm4SshxZlp26WMWWxTo4waLnHZMn1u9kKMQUSeySIN5NoOaNMXRwoHwHx+fBfVzawefnrBayXQtcQvq9zqnFrfmTJ66
BObmWrsi3q4MDdnHwzq7/n8x5S1YJ2aj5LiGDXufU4lb+yRPXxpxcOctd08Efg/Pg8xavFFJBBm1ayCZxm1fIuZWzHP8o0wUzuH/7Dq
7t4HMXrbBIx48ff/DgAf13hnrAMmHJXFmr1m1R5V8xHA4v68u5i1eyWrX+eXuUBcBiYeH2KIt7PD8Ai129/nm2G8NbO9Zr3RYH7C/g
ySkL9Ntvv92+ffuTT49y4y3VkjzLHBxgHRxQxcEBat6Y8h38MbgefE72cotkD/smwJK5ssBn6TS1cXBZXHO3X1kAd3BSsSxDE7dfWYb
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o8r7e+KBNuHtjOC1NSZZxVraOO346Hqyp5oWhTCSF9DM8hP4Jd6qMWgh8DzD9JXHWZVrcWwg9AJpmE/cpQ9guHjF7Such/GbIu
k1mvJIVKRpAXqjlC65FZOl7FF7AHRkYdyZ5X5FC47Iz3GyzuGaYhkHsZQQ6eNp0NMG8XQBoS3+3q8BBiDljk9iywOFi4tWd4xaMlG
W55h5wFri8zNi8Sfp3aArS0vl47T9V5wQwJ1DdS3+c8iICsQeGNasmQJjPXx8YFDERkDA/AWRsIkMoZg2Ofx8Yvnu6IICMTklY7SPyR
LaZiEdYLVKZz9IBu1IU8QyNHdTimcPeLKzqI3QEGHQzx+Om1f1Bd0XZdpeKix0YZKFo7akv4BlR0jD6P2OT2LLkeeHxUhYTiSjNFry
WT9ja2AvLa4LWfR7qDbCHIHAbimbksKl7oSgMvCpRt2K3k2+nGYElqwHq0S+hS7xTgZ7HfmYC9Hjdw82oN0UQO6ktytYIadumEj+
cBKrOieZlP4jtmakB1nD+inbWM9kf2Ka3UKZ78YswlYXjgZY1MKN/JB3m3o8mVPMFIjrixDlZfC+QaJDzEFMMx0MQxthKidU6Rmaa
QBc70MjaGgeZi3uAsw72GZ8E5asrEjV3DWdFqc3FWxgRgPYbB9aDsjsClcPsqgg1HeEbsdqspNrrAyuqm6FM52Ujyi3DUE8JwojlOk7
xXos7oxhjMYOXZj0IbCMOsP1THydcWWIzKdYBr5I7h96tksGWnuCMI0XdpmcBMlLd9wgbxv6+ZhliALH1yk1g7LpI1Zt0x+NZDQCk
ugBeKFyJ9FTN/Lrpg8v279mWMEmYdKXgbtEXid9Q7fTBeGQmnRJj8rh0NppN5K4jEuL2UpHFUcbSnDFoNmI3sX7xim/Rk2MrxNY
Zjd7uwMxj9lUoadB/XkV+hxnA5j46A9lpgdGZCO98gO0DC2NvpZ5D6oz+v8iA6TQRno5F26dIHGAF2d9HZ4K1uAjGGfh3l4dAdUXfC
Fg6J07k0eySVmVVI4/QKgd1Cnww5I4dh0UHeiFmMQ++h4vWH9JkQEbQbPBg0RL9/YPOzC5WH4oF6355qo3LDZFk6G9YqQ19Ng
BeQBmCLNz5bOdhCpplS2pHCdYAVwWdKm1hXKdjQ6zFbTrLj9LnUlHegIykYH2h9xn2I7F9MfVQQaqkXd00wK35GhCdn8JboiRZeJj
fVEtgeZOH9s2HfoBAk+hcsLZxdIhtniGMotAqdwBrxYI24jL99EXQCuLEMpTOHGuoORHveuNBudwVQDNr9YnWBWqWPqF6T/EdY
W+GOitCjjgu1D2xlBauomuoZqhyo6bABTrgwshJnf2MfhU1Ip5a0hLJydjcDMwwMzSxtEqpQ8jGoqhW92GBUkz8wCDdK6IzKdYBr2I6
hRUWhjgKZSzhFEbmb0SIfO3eDWBaNMtyLJt6WmaOQAwRaka7HySGOrwTVsveOpkaWxhUrDsCj9bkjFjJe6nrGPs2slD5v4rLSqeO3
xt3RpUz8+UngunEraMXSL0NnItmN3jJF9CcPSNmX3gdGmg0eWu60NO4+RnqzEOJRYm2lIzzfa2wmGfR7m5GDPQmHQwc9RKdzg
oKuDLU6HYRG0qqbRfYRvV3IvZbsrFp2THS8NS01FPsrCVGgzTJvMygrlWy+Ska7ONjZjTVT+CNvCidjZ2PXnVkCeDfcbMj9bOttB9L
aATSkcF6ZbH7rmaCtNJwcD+lb/U8aqaUIm97vU6aAPVmAKJ0BzVdg9TabwFWn9aK+k4F5prCfaI4XLyzFcoE0pnP9gxaZwWXoN0k
xTRH0K9S/jDbi8XiYNw6xSx5QLkoaNfEQqlM5msPKGgu1D2xlBaupM15Cw/6EKYaSvGU/hUnEIWFsLUrgOaVX5QqXVBmCZeJKRY
7d+8mah62MCaJYKu7zxfWQME+0cGgFthOUcQegwTA1eX5CF2xUazppOsjhZGhGeW9+3paaIFs4dINiCdC1WbqjGVoNr2GiB8mx
GlmasUFiU0Y7JjGeTtPRxg+JA8rCJz0qrymwWIqk6ujEuK+tSON5MGPT/Arrt0CZDwFt2K+NPEehGNJjKNB06Hn2ENmuDrS/JsPMg
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KVkYex5Nno5oWVZGZg1pMX7FnaxAlyn5K6D+qPSlI4norg84EjgFqQ6phI4XFpfppxO5lfZ6LuQ/qdsZ6IAi4ie4ENKVyHfgdnei5KzDa
lcBZSioHb6JYvT+JrxJVlKJtSOIjrcXJ3xy2czGOkARv2Mmk5egtBVxGQOaXuAzMz7V/yCqkstBDJgphSGAPhBduHtjOClEeZriFhv0MV
WrKE0aMYFCGP13VMeYF5eWZSOKwQhG8EvlgFLcfYmsi1wEuQPoKvQpE3iIRUIwQzntkgthkF12gtO34xLdBYA2COIHLTNWWnT
BNiJbdn2belTqF3iKFCpehWgymaPVZidKsht/asLC4WG10aqSAFT2X6CC95+zAbREJaJd0CFVyRQtcBbyzmoMYuzdVlOoU7vaB70F4l
AT1W/j7tPMB6cqtNj2D2wQHFcUXYWcasx6xQRzVxUHSMLFsB2SWxy3BTFadwhQIvU828oBnQJu7KyI3ZRAoX90gxB1eWocyl8Cd
AsH1oO3NycEpm46+DUXbsxl/XjX6RsIRyG62QerL48P0EyoVTOAi6k/NjuM70CGYfuBLtUZxhpYTsJLVTuMqCluDqyHURKdwKuLIM
9YSncBBsIoFTwe0gIaGKlWuncFfU8ePHCwoKqB+oDSwZlm/X4gyLELKfnDyFP04y3NTNmzf38fEJCwuDLD5t2rTZs2fTPmAtFdI9VS
9CRokViBQuJCQkZEYihQsJOa8Mo6F4gr2dZPgEe/GFR0hISEjIrhIpXEjIeQXJj0vhQg5T9+7d4QuPSOFCQkJCQnaSSOFCQs4rkcIrUL
6+vvHx8WvX5r/33vsihQsJCQkJqS6RwoWEnFfnz184e/arDz44vGPHjqlTp4WHo8skIB36+fl1797d3x/eCVQDtidsVdi2sIXhLWxt2Oaw
5WH7w16AfcHtHSEhISEhIVskUriQkPPqwoWL33773cmTpw4f/vDvf38dEuH69QVr1+avWbNWyH6CLQzbGbY2bHPY8rD9YS/AvuD
2jpCQkJCQkC0i9ymm1K5br7NfQIfOXdt37NKyjedf/vIXOkHgKJ5++umZM2fS+5oKBJiHDx/eu3fv1q1bN27cuHbt2p8C+wPbGbY2b
HPY8rD96Z4QCASCJ4mPPvqoc+fONKAI7E2duvU6+fl7de7aDlJ4W5HCKwCRwgUCgUAgEDgDIoU7FHIu3KtLN5HCKwqRwgUCg
UAgEDgDIoU7FJzC/Tt0EefCKwyRwgUCgUAgEDgDIoU7lDo4hXuhFO4jUniFIFK4QCAQCAQCZ0CkcIeCUnhXKYWLX2dWBCKFCw
QCgUAgcAZECnco7BUpHm3au2IKN7XOrlIXkcIFAoFAIBA4AyKFOxRyRYqUwp30XPhTTz1Vs2bNFi1aQMvo3bv34MGDQ0NDQ0JC
hgwZ0r9//xo1atD5jAE1qly58rPPPguz1apVq06dOtWrV69SpQqd7ASIFC4QCAQCgZ149OjRgwcP7t69e+vWLS0GBuAtjIRJdCaBhBO
mcBLkqlatClnuOQwMwxhXOdlqDua68C4tneZcOMTuhg0bBgQEhIWFRUVFRWKGDx8+bNiwiIiI8PBwGE9SeGBgIMxMP2YJsAvr1a
vXtGnTBg0aPPPMM3RsRSBSuEAgEAgEqoMevPCvj8rGjCpLGlYWH16WgPQgdeSldcu//PLLS5cu/f7777dv3xbPB2BxnhQOObtmzZq
NGjVq3ry5h0erVq1aY9oA7dq18/T0bNeufbNmzWrVqlWlShVXTeS1yf3CneBOhVA0bOsBAwbExcUlJibGx8fDQExMjJzCR4wYwaXww
YMHd+jQgX7eBmD/1a9fH/Zw48aNHZ/IRQoXCAQCgUBd7t+//2D+FJK8DRR2JSVy8+bNhw4dunjx4rVr12Bm+rEnHmdI4ZC/a9eu3
bRp05YtPTAQ0PgU7uXVoVOnzj4+vl27duvYsWODBg3gU/TzLgS6LrxrgHQuvAJSOGRQ2KAQtdMwKSkpycnJkMITEhJICo+Ojh41ap
SpFN6kSRO6IDV46qmnqlevDjsZ9na1atUcszVEChcIBAKBQEXu3bv3YOFUg/Ct06PEoSNHjszLyztw4MB//vOfmzdvijPihIpN4ZC7IBT
VrVu3WbNmLVq0BJgU3greNm/evEWLFm3atCUp3M/Pz9/fPyCgB6yzm1tj+CxdkKuAnp1JUri3Q8+FQ0HwLQeC9ThMRkbGmDFjL
E3h/fr1g29LdImqUqlSpXr16nl6esLOtvfZcZHCBQKBQCBQC4jg95fMLEscyiVvWTdjQ2d17wIRYtasWfv27Tt//vyNGzdECidUbAqvXLl
yrVq1mzZ1h/QFoBje0sPdvVm9unVr1qhRv359iI5ubm61atWCkNamTZuuXbsGBARAEO/Y0RsCOox3sTPi+Fw4ui68vaOuSKlSpUqXL
l0gdmdmZk6cOHH8+PFWp/AePXo899xzdLn2oWrVqm3btu3YsWP16tXttHFEChcIBAKBQBXu379/b8VCdCG4Qfgm0saGTO7s2alTJ
8gY69ev/+STT3766afbt2+LX2oSKjaFQyKCqO3u7o5PeSMaN27cpEnTbl27BfYI7OTt3aZ1m5YtWjRzd2/apGljt8atW7eBCO7n15VcIw
7R3MVOh8u/znRACof8DRtrypQpU6dOnTx5so0pPDg42NfX1zFfemDN27Vr5+PjU7NmTdU3kUjhAoFAIBDYDorgm1Y/Sh7OJW9ZN2
NDk73aeHt7Q7RYtWpVcXHx999/r9VqxYlwGedI4c1ICoc43rJFywD/gP59+w8cMHDwoME4hbcE1a1Tr369+s2bNe/UqTN8p/Lw8IC
ZXTWF0yfY2+268EqVKnl5eU2fPj0rK2vGjBmQwiGLsyl87Nix6enpkMJTU1OVp3BPT4deyP7MM89A0wTUPQEvUvhjibg3lkAgEDgSc
Nc7r/710eiRXPKWpY0JGdq2FRzEIV2sWbPmgw8++M9//gPmDB+kixA40blwdAW4m5sbBOuOHTqMHDZiaFg4BO5uXbu1bt26Qf36
TRo3rlOnTu3ateFt+/aeMHfTps6YwiGmQmiElYT4unjx4t27d9MJBP07Fdol1NaoUQPi9Zw5c2bNmkVS+LRp07gUTs6FAySFJyUlKUn
hzZo1o2U4Ctg+DRs27N69O3zrsu4OiYaIFP6Y8fDhw/uH3y8bE0WvSoxHepgy/NLa3GPHjl28ePG3334T98YSCAQCFYEkffvgO4/SRr
Gxm9XtuNCAls19fX0hYKxfvx6y5g8//CB+lGmIM6RwyNPNmqEY3rhxY09Pz+AhIQHdA4L6DxgeMbxtm3atW7Vu1ap1rZq16tapAzE
doqCHRyt4bdq0qTOk8EqVKkEVevToAfm2oKDg5Zdf3qMPnY+gl8Lbqny/cFiaj48PhO+5c+dCCp89e7apFE7OhXMpPD4+PjY21lQK
HzJkCNSTluRYnn322U6dOkFnVuWkuEjhjxNwJLi/ZompSxKvJQ3bVFDw/vvvf/fdd1evXr137544Ly4QCAQ2Akn69sljj0ZHcpYr62p0sG
fzZv7+/hAztmzZ8umnn/7444+3bt0SEdyQik3hVao8Xa8e+gkmpGpI4RCyIYj369svc1Jmxpj0QQMHhYeFB/j7e3h4QBKHqbVr14YZmj
dH1640adKkQlI4ZMJ27dqNHDly8eLFhYWFELtlaO7Wh36MoH9FipopHDZESEjIAoyZFD5hwgTzKTwmJoakcKghpHBg6NChJIVXq1
aNFuZwKleu3LZt2+7duzdo0ICOshaRwh8bIFIjW0+P4Q4ArG4mDJ03Mwv64alTp3799de7d++KIC4QCARWgyL4fy6XpZq8EOWriP
4Q6fr06TNp0qSioqIvvvjiypUr4ueYpqjoFF4FknSTJk3d3VEOh4Tdvn372Ji4CeMmTpo4KTUlNSQ4tHfv3p07d2nZ0gPCOmSwhg0bwq
wkhdeta/cUXqlSJSgUmhMk2HXr1r344ot/Y6DpW4LEbg66IIL01B5I4T4q/joTtiNk6EWLFmVnZ0MKnzdvnmEKnzx5so0pvGLvRwPbq
mXLlj179rTxnuUihT82wMFAq9X+t/i9+6YvTARp48OnZ0564YUXTpw48csvv4ggLhAIBNYB5nnnzz8fpRk/C343LuyFPl1btWo1aNCg
WbNmQQA6ffq0OP1hHudI4U2aQg53b+bm1hhWJjE+MWLosPi4+LHpGd27+vv5du3S2adhg4boTLlbY8jEMCskcojsdevWVT2Fk3vl
RUdHL1myZPv27S+99BIJ3KagARxDYjcHXS4Bp/AAdX+dCWscFxe3ePHiclM4fDG1OoUPGDBAxTP31vHUU0+1aNGiZ8+e8D2MjrI
ckcIfG9Dx4M6dn3/++ew7b91PNnmfLBAE8akTJ+zevfvLL78UQVwgEAisAGwTzPPhxETOYIluxoZO6ezZvn178qu4N95449y5c3/88Y
e4FNA8FZ7C69at17gxpHAUwxs2bASh3Luj96jIUZHDR3bv1r1vn77eHTtC4G7m7l6/Xr1q1arBDDAz5HbI5DamcEiVsALkOe7Tp09fv
349HKZffPFFSN4sJG2bggZwCRq9GWhhBHxFivTsTDWuC69UqdKIESOWLl0KXxqUp3BASQoHRowYOXz4cOhU/fr1q6xPJVCl8qVu
docg3q5du969e1t9aYpI4Y8TDx8+vHXr1o8//vj5gffvpYzgjgqs/hcbmpmZSc6Ii3MzAoFAYCno6TyLsjhrJYIIHtKmZadOnaKjo1esWPH+
++9fvHjx+vXr4kn15eIEKbwu5Gl8OrwpBOL27doHDw4O9A8cNGDgyOEjPdt7tWvbvm2bdrVr1a5Tp279+hDFUQqHXA4zwxiLUjhE
xzp16nTp0iUlJQXayY4dOyBzG0LTtwSN2yag6VuCRm8GWjYBUji6IqWzOufCIZL26NEDvnSaSuEQNyGIW5TC4+LiZs2a/ffX971/4IPi
Qx8dLP7w/QOH97//wd433nl+6+4tz+/evGXXps1FGzYVrt+wI3/99jX5W1ev3bpqzfMrV28hWrVmy5q1W9bmP79u/db1BVvX5m9amL
00MLCXWv+2qFq1KjRZf3//mjVr0lGWIFL4Ywa6SPH27f/+97+ff/bZddPXiD9KDD8SGQzftqFPnj179vfff4cjCl2EQCAQCMwCefruptV
GfwqvjQ3p1My9a9euECcKCgogVv7www/ijoQKcYYU3qiRG3pWT5OmDRo0hGzdM7BnRlp6alLKgH79g4ODu3fr1rJFC4+WHo0aNq
pRowakcJjZzc2tYcOGEKnNRDvIqNWrVyc3DYRcumnTpl27dr3AQEO3MWgAx9C4bQKaviVI8maha0Og14WTFG7zdeGwLSB5L1u2L
Dc3NycnB+K4pSl89OjRbApPTEx84YW/ffjRpx8c/viVV/8+Y8ZMiOWRo0aNGDEyMLDns88+x4hSFVTVQHh8jRo1O3Twzpo5b8PGbZ
s2b5+/YJEqv++EjQb5u3fv3vB1yooNKFL44we5NOWXX345ceLEhXlT7yVGcAcJoptxYTuHh8yfP/+NN9749ttvr127Jg4SAoFAUC4ogr
+w41GKkafz/Bg5qIW7e2BgIOSK7du3Hzly5KeffhK3Q1GOM6Twhg0bkbujQLD28vRKiEvMGDN2/LjxY9LGDBo4uFfPXj5dfJo3a9EU/
zoTkifMDGEdhmvXri2ncMhjMAyTevbsCVFz3bp1O3fu3L17918ZaPqWoInbGDSAY0jaNgVN3xI0ejOQ1aOgJ9iTe6R423ouHL5kREZ
GLl++3KIULt+s0DCFA9Onz/j4k38dOvRR7rI8WPjw4cPl68Ih8tKCLQTWMyAgcPOWHWvWbvD17UrH2gYs09PTE4I4tAM6SjEihT+
WQBC/d+/eH3/88fXXX3+yc9v9JONBXBsXtjRyGHSZAwcOiEe4CQQCAQsY6YNPP3ywMvva95fATv/888+bN2/eBvbueWRwU5RHie
GfhfZp0aJF//79IWZAcvryyy//97//3blzR1zvp5wKT+F16tTBNz6BPOVWv36Djh07JsYnxsfGj04ZnTEmo3evvv7d/SGFN2nchMR0mB9m
hggOQC738fGJiYmBFAqZe9euXRC7ueTNQtO3BAncRqEBXIImbmPQ9M1A07cErSpBl8JtviLF3d0dcrbRFD5//vy5c+cqTOHkIfYkhc+
YkQUp/P33D40fP2HkSHRFuJzCO3XqRAu2mL/UqVN33frNkML9/LrRcbYB2w2+vcGXb29vb2hDdKwyIIXPmDGDNn/B48WDBw+uX
79++fLlw8XFv2TEPdI/ZhDdjQ+bFhcDX9PB+0pLS8U5G4FAIAAgOt/9sYQ8iOdRUsTvU9L2v/32kSNHruza9tAggoOR7unbvVWrVkO
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j1qt9u7ZUw+Wzrl28fwff/wBOR6WIC5WEQgETxToLMalCw+ZZ/HcTYw4OybunsG14LfjwtYF+LRr1y48PBxSB7kdytWrV8VvMa3gg
w8+8PT0pAHF4UAiglQNIa1u3XoA/GnTps2ggYP8u/n379d/WMSwdm3bt2ndpjV+dmad2mi+mjVr1qlTp1at2u7u7rGxsRalcIDkb2DH
jh2QS728vMgvPqF8WAcQrAwsvzZ+Wj4U16lTZwix8EGSuQ0hyZuFpm8JWlUCc7/wLh62pXCIzitXrjSTwuHrKZvCp0yZYl0Kj4iIcMI
U/tRTT0Fb6du3r6W3D69cuXJMbDxt/oLHEXJ1ChwSvv3224/2/O2BsZ8T3UkIn5eWumXLls/2v/swPZqMvDk27q233vroo4/gg+IGWw
KB4IkCMjT4nmySpnQzNjTbz7tt27YQwRctWvTmm2+SOxKKs+DWceDgwVatW9OA4nAghUOqhiAOqbp27TowDEHYv3v3MWljkhIS
e/fsPWRIsJ+fX7NmzTxatmzYoMFzzz1XrVq1GjVqVKtW3c2tcXR0tHUpHOLr4MFDGjdu0qiRG6iBW+P6jRo3dm/a3quZX9fm3p2aujd
rVLdefUiPsFYNGjSE1di4cRPN3QbQ9C1B07cErSpBdy7c26ZfZ0IGnTVrli0pPCMjg0vhgAulcNh0kL/79esHWZyOUoZI4U8IDx480Gq
1P/zww6eHDt1JMfJYn7vxYYcSRrIny28kDoNOkZeX9+677168eFFcNS4QCJ4cwDPR+eyxcbIlGuphQvifMSHXYkNvxIc/Shz6MDHi1tj
Ykm0bLly48PPPP9+4cUOcvLCUikrhEKIgTEO08w8IgDwNURwEYzw9PZMTk1OTR4/LGDc2Y9yA/kE9A3v6+vi6N23WpEnT+vXrV8
U888wzMDxq1CgrUnhBQQF80L1Zs6bu7ihuN2les0GzZ+p51GrepUvPoITU0Nlz+0+d2i0kpG1Lj8Z166IsDnlvxIgR27Zto7lbH5q+J
Wj6lqAVJrDnwlu2tv5+4ZDCIXabT+HcFSlGU3haWprCFO5U14UDsOkaNGgAKbxDhw50lDJECn9ygAx969atn3766ciRI7+NT+AOJ4
b6T9SQvn37Qk955ZVXzp07J26iIhAInhzA7sD0biyZzRmjed1NjHg7c+ymTZvefffdr7/+mtwEVgRx5TgmhUNkgtzcokWL8PBwCIfr1q3
bsWPHzp07IRAnJ6c0b96iVq3aNWvVrl6jppenV3JSclJCUnpa+riM8X379OsREAgpvGkT9KSeenXrVapUCSIoLLB27doQFI2mcICGbg
Ng0qJFi3r17t3Sw6OlRyv3Fh61GzZ7tn77Fq2GBbTP6OEVOazfuLiw7P4D4lp5ezZt0aweulq9Xr169Xv06AFxl+ZufWj6lqDpW4JuAoLe
rzNteGoPbIIlS5aUey581qxZVqbwCSiFwzcPOYVbfY8Ue6dwLy8vOkoZIoU/ITwo+c/91168uybn7uyJt2Zk3M6IKTNx4xRZJyIGBAYGQ
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EEQLoVZ+I4dmkvFjlh4nji77sqsdcoNKD9nz5qVfRYf2Ni35PLivXxInkAahpkoqg3+fVW6k/zaYsMMwcIPHWIXwr//HnJp3z69hUdHay
zczk3hEIIgCIIgCIJwLh6HD1/aubN4Wbg0Q4u5gYULBT969MqRIxf37ze38M2bhYWfp5vCCYIgCIIgCFfikZl5affuwrVwACRbuXtEvow
tc2PtLM0ETLvxJVfW/iw/VO4/2XtVdyOKCli4UPDjxy8fO3bxwAGNhTdqxCx89mxm4SdOaCycFJwgCIIgCIJwAR5HjlzUfYVIYVi4DknK
ecyuZ+eba9dy2rbNEQp+8uTl48cvHjqkt/CYGGbhW7aAhf/w66/nTS+EEwRBEARBEEQh4XHs2MWMDI2kusDCCwnw7zVrmIJv2vT
HiRNMwU+fhr8Xv/vOxMLnzAEL33ryJFk4QRAEQRAE4Wo8QFIPHtRIav36TUJD4ydOfOOjj7bv3Jl14MClgwevHDjAvn57/36WjAzMv
n367N1b0OhmCFHfTry7WBJYpEOHrhw+zD6CmZnJbgE/cuTKsWPs+rfq3z/8cPnHH+Hvhe+//1EuULHw17/5hln4b7+hhcsKThZOE
ARBEARBFB4eHx/c+P7Oj2VJrV+/cVhY3MSJr61Zs3XnztMHD547fPjioUOXIAcP6gOObpX9+x2N7oVydG8HEUty+PCl775jycxk+f77
i0eOXDx69OKxYxePH7944sTFjw5uXHNw4+nT50+d+vXw4ZNygY0bN4mNjRMWfuoUWjgpOEEQBEEQBOEyPPw+92u3up0sqfd9
Gjb0iYmJVS383LnzpOAEQRAEQRCEK3kQLbxevXqxsXGvvz73f//bdvo0WThBEARBEAThajxaDS3p0diz0VvN66bVbZrULCAgyMenSZ
069erWrd+ggU/Dho3hoTENG7o6ugWwSunaZf5b67+QJ178m8fjjz7Bh0t7l27Y0Kdevfrg340bNwkMDBwyZOjSpcv27Nlz5kzW+fMX
yL8JgiAIgiAIV+LRelhJj5e8mq9q2/zt5o1mNvKd5Pf66wtmz37j1VfnQmbNskx6uuuie2s5YiHF0rYc0cpzkKdIdf//eFQuXV15CE/NmfP6
66/PnTdvPvj3unWff/vtt6dOnf71198ugISTghMEQRAEQRAuxMN/gz/Eb72f31q/9p+0b7emXedPAg8e+f748R8hx45pcvRo0Ue3SGIhY
YE7fxzYbnU7Own8OPDw8cwffvjxzJmsn3/+BfybroITBEEQBEEQRQJauDHf/phx7twlnt/l/PZbUUa3MGIJv/1xv27h7WRfVoZq3uTfBEE
QBEEQRJHgIUxUfGG2ac6fd9/oFlWOKtl2QhAEQRAEQRBFAlq4aXRe67bRLbb9EARBEARBEESRY8/C748QBEEQBEEQhLvhgf9K6C
y2GIUgii8XLlz47bfffvnll6ysrB9//PEH4r4GmhgaGpobGh2aHjcCgiAI4kHCxMIJgnAlFy9eBBXT/bYU5b7PsmXLPv+cfWXq6dOnYQNg
X5hKEARBPEiQhRNEEXPhwoWsrCydolHu+wQGBg4dOhRcfM+ePbAB0BVxgiCIBw2ycIIoYs6fP//DDz/IflahQoUaNWo0a9asc+fOkZ
GRMTExcUQxBxoRmlJu5Xr16sH4uXPnbtu2DTYA2AxwgyAIgiAeDDxOnDhJoVCKMEePHsvI2C/7mZeXt5+ff//+A1577fUPP1zx6aeffv
bZ2rVr11GKaaD5oBGhKeVWBgsPCwubOnUaTAAbAGwGug2DQqFQKPd3yMIplCKO0cLr128AfjZp0mRQt2+/3ZuZ+T1MQynWgUa
EppRbuUGDBuHh4WThFAqF8sCGLJxCKeKAfuksnPzs/gu1MoVCoVB0IQunUIo45GcPQqiVKRQKhaJL8bDwIUTe0a1DdwsuJTFkyOD
Bg/v27Sv72Ysvvujl5eXn5xcfH19wP4O3yCGKAljzaisUawvn22nxRlcRhUKhuEOKgYVDB4rHNCIvuPOBh9pU5s6dO5cvX5b9rHnz5ik
pKe+8887BgwdB0MnCiynyPlh8Lfz+2H7cuT+kUCgPbO5/Cz+7PMiDEbQsC8fYZ/s4j6DlZ/FBccY5R52VAzx803doRu6c6cvXqH58H
mLaprDmPTzGb8dHRUTWsiDnLQPf9nKfG1n4/Yq8D95nFl5Ie6uDu0w+cE5/SKFQKE6NRzuPdjO3sqEV/Tw8+q2Un8tbtqars3JuDM
eAs8u62kSZ99rWhp13qVIsnL3L+B040q0YO3bs77//jg848DAtLQ0fKEhHHfTmduk7xRjW1oAjzW2w8B3QzgXZTniMx3VY7a5d2xbt6
1QL52wfb7F9qu2YBwu3NQdrU7VBWaNY732atb1jvEfXZbazTHhoXS/sXLijwWrBV7H1xlFfpdkfmZyN083PfXelwsa2D0LDMVrJrVzd
QQtnXeuAFbqREDZPs/HOjsv3VstdxpS894cUCoXiLuEWnq7rzW0HeEW5oL/HY7ylhOksXKsLA1aKCfiAmAk+y48kfCSooe1NJfMzHA
M0R32Gak42pVD6cVOpUkYyg1eMRB12cwuHA4ynpyccz728vGAYgAF4CCNhGCfiSEcd0aArZ/ryBlo5ANaz7aRLbSlbC0qGpz6rDEg
bgNKyJhsMGyM1oq2VRfRtal8N5YfqMBtQGog1qPbETMxNs2HgxIomWrSvyQajTmmTA/YW3DWN78Xmr5sDvLteTDXteOHChR9//F
H2s7xaOIvN1eyubVgYO6tagyxD2tWlWUvy/igPCyzW84OBbR9kbdJ/ccYSuZW5hbdp7+ERM5NZ+Ad9RYMqzae2dX4sXNk31ZnkYW
/VX5Gxv7dKGzxsMNjW6g5i28DYAD6r7IPy5qc1bxhv2GVMkfcj1hs61B9SKBSKu0RcC+e9sNrtcl2W4B296M3hKamz1sTmcBhh1dD
RoyvIxxJ1mB1IJMxmrj8GGI/0GgGywaYx6IICG2lTKGkYZsJn7tb2AAcYcewBjMcbgXTUUY67rPnaiRZUDrS2QzIET4TkllKP4sqAiYWz6
WXgtcpTYiaGmBzXpYOu0gQKtkO1NAwDqgpYtjKDNaI0B6WhLdpXmhWbUgGnFG8K0+Bbm7yXfuEB2/R65HaU/axgFq6PZm3L6w
2Q1oyBfFi4boYWK/mBwbYPso4OLFxzRwqz8Da1ROsjSgeo8WCrlmXz1I9nu6eC2AHN+mEZJ+ytykN1S7DpuG0bkDYMubOVsW1F1
ruMKXnsDykUCsVdYrsjhffphkuhMNwPDwy8f9d4tiasc9c9y+ZjE2vpWCIdY/iRBA8AKwfwkeyN1FflZuFclRRXkA1gx3jW9dt0QRICdT
Lb9OxZ9cAgZm6iU24GHGxMjzcC6ahjMDa5CVSxs7WgrVHYZOJZZTITCzfZYNSnRORWZjG0KRy2lYYD5HYEWCNiE/PDttJ26nFaI4
W2YzwfHs9eKM1QNgCT9lVmxSZDt5CVQru9mb2XcbYwjf0NqeDXwrX7pv21rTckOxcdbUuusyLNCjfsjziltMc9qNj2QdYmZhYuXQs/
evRD3gHCpLwpeTPyDlMZozSoNE+NhUv7Jn8OtwG2qUg9aq57q/YcILe9le2Segvnm4EYadLZShuJvKeLHpuT6y5jisP9IYVCobhL8vD
pTOia5Z7agcCRQDpIWF3RyS2GYwDhEO581DFpU61Juy3gHHkyS5uOWEOfzrxfkfdBaMQi+nSmth/Oe1y8tzqyy+QDd+4PKRTKAxv
6psL7Fnc+6lCbypCF36/I+2DRWXhBc39sP+7cH1IolAc2xeNXeyiU+zhWfjZlytTPPlu7b18GTHD8+Andq/IUUBDC9ajrH5oPGhGa0tj
K7m/hFAqFQimkkIVTKEUco4XXq1cvODj45ZfHffjhim+++d+33+4FgYNpKMU00HzQiNCUcivXr08WTqFQKA90yMIplCKO0cIpD0L
q1KkTFhZGFk6hUCgPbMjCKZQiDujX/v0HdIpGue/ToEGD2NjYmTPT16/fABsAWTiFQqE8aCELp1CKOMeOHT98+Ltt27Z/8MGHkyd
P6dOnL8hZeHh4GAcGiPsGtU2hiaGhobmh0aHpYQOAzUC3YVAoFArlfs6Jk/8PVekkn1jIyTQAAAAASUVORK5CYII=" class="c24">

Now save our work, by clicking on the Save icon.

 

We have completed the touch keyboard for the Dagbani language.



Note that we would not usually add multiple ways for entering a special character like we with
the open o character.  This was done for demonstrating different ways for adding special
characters to a touch keyboard.

 

 

 [1] https://lingtran.net/


	KDT15 session 6

